
Alan’s Favourite Tips – Part II 

Excel Tip #1 - A quick way to delete blank rows in Excel 

Deleting blank rows in an Excel data range is easy with this technique but watch out for 
unintended consequences. 

Blank rows aren't bad, but in most sheets, they're definitely undesirable. Excel uses blanks to 
determine data ranges, and a blank row in the wrong place will inhibit many built-in features. 
Fortunately, there's an easy way to remove blank rows from a data range, but this easy technique 
has the potential to destroy data, so you must be careful. 

 

After selecting the data range in Excel, continue as follows: 
1. Press [F5]. 
2. In the resulting Go To dialog box, click Special. 
3. Click the Blanks option and click OK. Doing so selects the blank cells (what you might think 

of as rows) in the selected range. In this case, that's A7:E7 and A10:E10. 
4. Now you're ready to delete the selected cells. On the Home tab, click the Delete dropdown in 

the Cells group and choose Delete Cells. Excel will display the Delete dialog box, with the 
Delete Cells Up option selected. Click OK. Or, press [Ctrl]+-. 
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1. Excel will delete the blank cells from the selected data range. 
 

 
 

 

 

 

https://tr3.cbsistatic.com/hub/i/r/2019/06/19/6412190f-9706-427a-84fa-02faf4049d15/resize/370x/0e0a39c516fa34e4a1d0166817fad4a0/excelblankrows-fig1-12002.jpg
https://tr3.cbsistatic.com/hub/i/r/2019/06/19/6a598e6d-5de8-4c75-8b7c-8b2edeb2eea0/resize/370x/5c78c9595813a74b3e3352884a5267cb/excelblankrows-fig2-12003.jpg
https://tr2.cbsistatic.com/hub/i/r/2019/06/19/cd2a78e8-af22-4e07-9270-ae184fe93fcf/resize/370x/a94bb4880f6d1e807ac2872115e2d99d/excelblankrows-fig3-12004.jpg


 

Choosing Delete Cells deletes only the blank cells in the previously selected range. If you choose 
Delete Sheet Rows in step 4, you could potentially destroy data (often unseen) to the right. 
Choose carefully when using this option to delete blank rows when you really want to delete just 
the blank cells. It's easy to think in terms of rows and choose the wrong option! 

Excel Tip #2 -  Use a custom format in Microsoft Excel to 
reduce the number of digits in a large number without losing 
its scale. 

Large numbers are a bit laborious to read, especially if there are many of them. To improve 
readability, you might want to reduce the number of digits, without losing the number's scale. 
For example, the sheet below shows a number of large numbers, some in the millions. We can 
reduce the number of digits using a custom format, but be careful; you might get some 
unexpected results! (We're specifically working with millions, but you can apply this technique 
to any scale.) 

Now, let's try a custom format and see what happens: 

1. Select the data range and press [Ctrl]+1 to display the Format Cells dialog. 
2. From the Category list, choose Custom. 
3. In the Type control, enter the $#,," M"; format string. The pound sign combined with the two 

comma characters displays a character in the millions position, if one exists. The " M" 
component displays a literal M character, to denote millions. 

4. Click OK. 
 

The results look good, but a couple of values disappeared! That's because those numbers are less 
than one million. You could add a few pound signs, but you might not get what you expect. For 
instance, repeat the instructions above and use the format string $#,###, " M";. (The period after 
the semi-colon is grammatical and not part of the format string.) As you can see below, the 
results aren't accurate. You don't want to imply that $21 thousand is actual $21 million, but that's 
what this custom format does! In addition, someone might interpret $1,794 M as $1,794 millions. 
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We have two formatting problems. How can we express millions and less than one million using 
the same custom format? Let's try one more time using the format string $#.##,," M";--the 
character to the right of the pound sign is a period character, not a comma. This format retains 
the scale, without losing any values and without misrepresenting the values! 

The two comma characters retain the millions scale. The period character forces the value to 
truncate, while the last two-pound signs display the appropriately rounded digits. 

Excel Tip #3 - Screen Clipping 

Insert a screenshot or screen clipping 

You can quickly and easily add a screenshot to your Office file to enhance readability or capture 
information without leaving the program that you are working in. This feature is available in 
Excel, Outlook, PowerPoint, and Word. 

Screenshots are useful for capturing snapshots of programs or windows that you have open on 
your computer. When you click the Screenshot button, open program windows are displayed as 
thumbnails in the Available Windows gallery. You can insert the whole program window, or 
use the Screen Clipping tool to select part of a window. Only windows that have not been 
minimized to the taskbar can be captured. 

When you choose Screen Clipping, your entire window will temporarily become opaque or 
“frosted over.” After you select the part of the window that you want, your selection will show 
through this opaqueness. 

Note:  Only one screenshot at a time can be added. To add multiple screenshots, repeat steps 2 
and 3 below. 

1. Click in the document at the location where you want to add the screenshot. 
2. In Excel, Outlook, and Word: On the Insert tab, in the Illustrations group, click Screenshot. 

 

In PowerPoint: On the Insert tab, in the Images group, click Screenshot. 



 

3. The Available Windows gallery appears, showing you all the windows that you currently have 
open. Do one of the following: 

o To insert a screenshot of an entire window into your document, click the thumbnail image of that 
window. 

o To add a selected portion of the first window shown in the Available Windows gallery, 
click Screen Clipping; when the screen turns white and the pointer becomes a cross, press and 
hold the left mouse button and drag to select the part of the screen that you want to capture. 

 

Tip: If you have multiple windows open, you'll first need to click the window you want to 
capture before starting the screenshot process. This will move that window to the first position in 
the Available Windows gallery. For example, if you want to take a screen clipping from a web 
page and insert it into a Word document, first click the screen with the website, and then go 
directly to your Word document and click Screenshot. The screen with the web page will be in 
the first position in the Available Windows gallery, and you can click Screen Clipping to select 
a portion of that screen. 

4. The window or portion of the screen you selected is automatically added to your document. You 
can use the tools on the Picture Tools tab to edit and enhance the screenshot. 

Excel Tip #4 - Auto Decimal Point 

There’s nothing more annoying than adding a decimal point, only to have Excel remove it. Or, 
worse still, adding decimals to every line, even though you’re using whole numbers in dollar 
format -- $12.00 shouldn’t require you to type a decimal point on each line, instead let it Excel 
do it for you. 



This all comes down to formatting, and thankfully, it really couldn’t be easier. 

1. Open Excel and enter a new or existing workbook.  
2. Select the column you’d like to add decimal points to.  
3. It doesn’t matter if there are no decimals, all decimals, or a mix of the two. 
4. Right-click and select Format Cells 
5. Under the Number tab, select Currency. 
6. The number of decimal points should be set to 2. If not, use the up/down arrows to select 

the number of decimal places (or just type it in). If it’s already set to 2 skip this step. 
7. Click OK. 

Excel Tip #5 - Enter the Same Data Into Multiple Cells 

At one point, you may find yourself needing to enter the same data into a number of different 
cells. Your natural instinct would be to copy-paste over and over again. But there’s a quicker 
way: 

Select all the cells where you need the same data filled in (use CTRL + click to select individual 
cells that are spread across the worksheet) 

In the very last cell you select, type in your data 

Use CTRL+ENTER. The data will be filled in for each cell you selected. 

Excel Tip #6 - Excel tip: Three cell formats that will make header text 
fit 

In an ordinary sheet, descriptive header text often inflates the width of columns, pushing 
important data off screen. Moving from screen to screen is tedious and often, there's nothing you 
can do about it. But, when the problem is the header text, you have choices. In this article, I'll 
show you three cell formats that reduce the width of the header cells so you can get all of that 
data back on a single screen. 

Figure A shows an example of what often happens when header text exceeds the actual data in 
the column. What you can't see is that the data range extends to column P--you're missing a lot. 
You could use a smaller font size, or you could delete some of the header text, but there are 
better choices. You might consider Shrink to fit, but I admit that it's my least favorite of the three 
formats. 

 

Figure A: The long headers require wide columns. 



To apply this format, select the header cells, B2:P2, and click the Alignment dialog launcher (on 
the Home tab). On the Alignment tab, check the Shrink to fit option shown in Figure B. Or, 
press Ctrl+1. 
 

 

Figure B: Apply the Shrink to fit alignment format. 
 
Figure C shows the results of reducing the width of column C--the effect is fairly dramatic. 
(You won't see any difference until you reduce the width of the column.) 



 

Figure C: Shrink to fit isn't a great option for header text that doesn't fit. 
The text won't increase if you increase the width of the column. In addition, the font size doesn't 
actually change. If you check the Font Size control in the Font control, you'll see that it's the 
same as before. This format has limited use when fitting header text, but you should know it's 
available. 

Before continuing, be sure to remove the Shrink to fit format if you're following along with the 
example because it'll change the results of the next section, which introduces the Wrap Text 
format. 

Wrap Text format 

The Wrap Text format forces text to wrap to multiple lines within a single cell to accommodate 
the cell's width. It's easy to use, but this format sometimes yields unexpected results and requires 
a bit of tweaking. 

Before applying the format, reduce the width of the column(s) to accommodate the text instead 
of the headers. Most of the header text will disappear. It's temporary so don't worry. Then, select 
the header cells, B2:P2, and click Wrap Text in the Alignment group on the Home tab. 

As you can see in Figure D, you usually have to tweak a column or two--or maybe even all of 
them. Specifically, columns D and M need to be a bit wider to keep the words Membership and 
State together. This format won't keep words together automatically. However, we can see all of 
the data on one screen now. 



 

Figure D: You might have to tweak the width a bit. 
 
Sometimes you'll want to rearrange the words a bit. Columns E, F, G, and H illustrate this 
possibility. You might want Last Name and First Name to be on the same line. When this 
happens, force a "hard return" in the header text. To do so, select the cell and position the 
cursor before the word (in the Formula bar) you want to push to the next line and press 
Alt+Enter. If you end up with three lines of header text, as shown in Figure E, simply increase 
the width of the column(s) a bit. 

 

Figure E: Force a word to the next line. 
 
Most of the time, Wrap Text gets the job done, but there's one more format you can try. If you're 
following along, remove the Wrap Text format from the header cells (it's a toggle, simply select 
the cells and click Wrap Text) and then increase the column widths so you can see the full text 
headers. 

Orientation 

If Wrap Text isn't appropriate, try the Orientation format, which rotates the font angle. Select the 
header cells, B2:P2, and click Orientation in the Alignment group on the Home tab. Figure 
F shows the result of choosing Angle Counterclockwise from the drop-down list. Many users 



press Ctrl+z to undo the change and give up because it doesn't help and it looks odd. But the 
truth is, you're almost there. (The online version doesn't support the cell Orientation format.) 
 

 

Figure F: Apply the Orientation format. 
 
Similarly to the Wrap Text function, the column width is part of the show. Figure G shows the 
result of reducing the column widths to accommodate the data instead of the headers. 

 

Figure G: Reduce the column widths. 
 
This feature has a number of settings, so if you don't like this one, change it. Press Ctrl+1 and 
adjust the angle using the Orientation control to the right. You can drag the text line up or down 
or enter a number in the Degree control. By default, the degree 45 is represented in both 
spots. Figure H shows the result of dragging the Text line to 75. To quickly remove the format, 
enter 0 in the Degree control. 
 

 

Figure H: Change the degree of the angle. 
 
 
 



Excel Tip #7 - Create an Excel Data Table to compare multiple results 
 
To illustrate their use, we'll add a data table to the simple mortgage calculator shown in Figure 
A. As is, you can change any of the input values to change the results. We won't spend any time 
on building the calculator. You can download the demo workbook or refer to Table A for the 
formulas. The IFERROR() function isn't necessary but consider using it to handle errors if you 
plan to distribute the workbook to others. 
 
Figure A 
 

 
 
We'll add a data table to this simple mortgage calculator. 
 
Table A 

Cell Formula Format 

B4:B5  Currency 

B6  General 

B7  Percentage with two decimal places 

E4 =B4-B5 Currency 

E5 =IFERROR(PMT(B7/12, B6*12,-B4+B5),0) Currency 

E6 =IFERROR(E5*B6*12,0) Currency 

E7 =IFERROR(E6-E4,0) Currency 
 
Now, let's suppose you want to compare results when the interest rate changes, not once, but for 
several rates--that's where a data table comes in. The first step is to enter the data table's labels. 
They should be easy to glean from the original sheet. In addition, the data table's first column 
should contain your variable. In this case, that's the changing interest rate. 



I recommend using AutoFill to create a list of interest rates as shown in Figure B. If you must 
use formulas, be sure to replace the formulas with values because data tables don't evaluate 
formulas in the first column. It doesn't matter what values you begin and end the list with. 
 
Figure B 
 

 
 
Add labels and then create the list of changing variables in the data table's first column. 
The next step is to enter the data table's references as follows: 

1. Select B11 and enter =E5 (the cell that contains the monthly payment formula in the result 
cell section of your original sheet). 

2. Select C11 and enter =E6. 
3. Select D11 and enter =E7. 
 
 



Figure C 
 

 
Add references to the original sheet's formulas. 
 
There's one more step to take before you generate the data table. The variable input cell--in this 
case, that's the interest rate value--must equal the first value in your data table. The first interest 
rate in the data table is 2.5%. You must change the input value in B7 to 2.5% before you 
generate the data table, as shown in Figure D. Do not skip this step unless the values are the 
same. 
 
 
 
 
 
 
 
 



Figure D 
 

 
Now, you're ready to generate the data table as follows: 

1. Select the data table range. In this case, that's A11:D29 (don't include the labels in row 10). 
2. Click the Data tab. 
3. Choose Data Table from the What-If Analysis option in the Data Tools group (Figure E). 
 
Figure E 
In the resulting dialog box, enter the input cell, B7, in the Column Input Cell because the interest 
rate values are in a column vs. a row (Figure F). This is the input value Excel will change for 
each row in the data table. 
 
Click OK and format the rest of the table as necessary. 

The Data Table option is in the Data Tools group. 

Figure F 

 



Reference the input cell that changes--in this case, it's the interest rate in B7. 
 
The resulting data table in Figure G shows how the monthly payment and other values change as 
the interest rate changes. By combining the original calculator sheet with a data table, you have 
the best of both worlds. You can still use the calculator portion to change all of the input values, 
and the data table will reflect the changing values with the fixed set of interest ranges (2.5% to 
11.50%) for each mortgage scenario. 
 
Figure G 
 

 
 
The data table shows payments and totals for many interest rates. 
Once the data table is in place, you can't change any of the referencing cells in columns B, C, and 
D. Excel protects those cells. In addition, the data table formulas are a series of =TABLE() 
functions--this function is just for show. You can't use it in any other context. 

 

 



Excel Tip #8 - Excel XLOOKUP Function 

 
Summary  

The Excel XLOOKUP function is a modern and flexible replacement for older functions like VLOOKUP, 
HLOOKUP, and LOOKUP.  XLOOKUP supports approximate and exact matching, wildcards (* ?) for 
partial matches, and lookups in vertical or horizontal ranges. 

Purpose  

Find values in range or table 

Return value  

Best match (exact or approximate) 

Syntax  

=XLOOKUP (lookup, lookup_array, return_array, [not_found], [match_mode], [search_mode]) 

Arguments  

• lookup - The lookup value. 
• lookup_array - The array or range to search. 
• return_array - The array or range to return. 
• not_found - [optional] Value to return if no match found. 
• match_mode - [optional] 0 = exact match (default), -1 = exact match or next smallest, 1 = exact 

match or next larger, 2 = wildcard match. 
• search_mode - [optional] 1 = search from first (default), -1 = search from last, 2 = binary search 

ascending, -2 = binary search descending. 

Usage notes  



XLOOKUP is a modern replacement for the VLOOKUP function. It is a flexible and versatile function 
that can be used in a wide variety of situations. 

XLOOKUP can find values in vertical or horizontal ranges, can perform approximate and exact matches, 
and supports wildcards (* ?) for partial matches. In addition, XLOOKUP can search data starting from the 
first value or the last value (see match type and search mode details below).  Compared to older functions 
like VLOOKUP, HLOOKUP, and LOOKUP, XLOOKUP offers several key advantages. 
 

Not found message 

When XLOOKUP can't find a match, it returns the #N/A error, like other match functions in Excel. 
Unlike the other match functions, XLOOKUP supports an optional argument called not_found that can be 
used to overide the #N/A error when it would otherwise appear. Typical values for not_found might be 
"Not found", "No match", "No result", etc. When providing a value for not_found, enclose the text in 
double quotes ("").  
Note: Be careful if you supply an empty string ("") for not_found. If no match is found, XLOOKUP will 
display nothing instead of #N/A. If you want to see the #N/A error when a match isn't found, omit the 
argument entirely.  
 
Match type 

By default, XLOOKUP will perform an exact match. Match behavior is controlled by an optional 
argument called match_type, which has the following options: 

Match type Behavior 

0 (default) Exact match. Will return #N/A if no match. 

-1 Exact match or next smaller item. 

1 Exact match or next larger item. 

2 Wildcard match (*, ?, ~) 
Search mode 

By default, XLOOKUP will start matching from the first data value. Search behavior is controlled by an 
optional argument called search_mode, which provides the following options: 

Search mode Behavior 

1 (default) Search from first value 

-1 Search from last value (reverse) 

2 Binary search values sorted in ascending order 

-2 Binary search values sorted in descending order 
Binary searches are very fast, but data must be sorted as required. If data is not sorted properly, a binary 
search can return invalid results that look perfectly normal. 

https://exceljet.net/excel-functions/excel-vlookup-function
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Example #1 - basic exact match 

By default, XLOOKUP will perform an exact match. In the example below, XLOOKUP is used to 
retrieve Sales based on an exact match on Movie. The formula in H5 is: 

=XLOOKUP(H4,B5:B9,E5:E9) 

 

Example #2 - basic approximate match 

To enable an approximate match, provide a value for the "match_mode" argument. In the example below, 
XLOOKUP is used to calculate a discount based on quantity, which requires an approximate match. The 
formula in F5 supplies -1 for match_mode to enable approximate match with "exact match or next 
smallest" behavior: 

=XLOOKUP(E5,B5:B9,C5:C9,,-1) 

https://exceljet.net/excel-functions/excel-xlookup-function
https://exceljet.net/excel-functions/excel-xlookup-function


 

Example #3 - two-way lookup 

XLOOKUP can be used to perform a two-way lookup, by nesting one XLOOKUP inside another. In the 
example below, the "inner" XLOOKUP retrieves an entire row (all values for Glass), which is handed off 
to the "outer" XLOOKUP as the return array. The outer XLOOKUP finds the appropriate group (B) and 
returns the corresponding value (17.25) as the final result. 
 
=XLOOKUP(I6,C4:F4,XLOOKUP(I5,B5:B9,C5:F9)) 

 

Example #5 - not found message 

Like other lookup functions, if XLOOKUP does not find a value, it returns the #N/A error. To display a 
custom message instead of #N/A, provide a value for the optional "not found" argument, enclosed in 
double quotes (""). For example, to display "Not found" when no matching movie is found, based on the 
worksheet below, use: 

https://exceljet.net/glossary/nesting
https://exceljet.net/excel-functions/excel-xlookup-function
https://exceljet.net/excel-functions/excel-xlookup-function


=XLOOKUP(H4,B5:B9,E5:E9,"Not found") 

 

You can customize this message as you like: "No match", "Movie not found", etc. 

Example #6 - complex criteria 

With the ability to handle arrays natively, XLOOKUP can be used with complex criteria. In the example 
below, XLOOKUP is matching the first record where: account begins with "x" and region is 
"east" and month is not April: 
 
=XLOOKUP(1,(LEFT(B5:B16)="x")*(C5:C16="east")*NOT(MONTH(D5:D16)=4),B5:E16) 

 

XLOOKUP benefits 

XLOOKUP offers several important advantages, especially compared to VLOOKUP: 

• XLOOKUP can lookup data to the right or left of lookup values 
• XLOOKUP can return multiple results (example #3 above) 

https://exceljet.net/excel-functions/excel-xlookup-function
https://exceljet.net/excel-functions/excel-xlookup-function
https://exceljet.net/excel-functions/excel-left-function
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https://exceljet.net/excel-functions/excel-month-function


• XLOOKUP defaults to an exact match (VLOOKUP defaults to approximate) 

• XLOOKUP can work with vertical and horizontal data 

• XLOOKUP can perform a reverse search (last to first) 

• XLOOKUP can return entire rows or columns, not just one value 
• XLOOKUP can work with arrays natively to apply complex criteria 

 

Notes 

1. XLOOKUP can work with both vertical and horizontal arrays. 
2. XLOOKUP will return #N/A if the lookup value is not found. 
3. The lookup_array must have a dimension compatible with the return_array argument, otherwise 

XLOOKUP will return #VALUE! 
4. If XLOOKUP is used between workbooks, both workbooks must be open, otherwise XLOOKUP will 

return #REF!. 
 

Excel Tip #9 - Goal Seek 

Goal Seek is a built-in Excel tool that allows you to see how one data item in a formula impacts another. 
You might look at these as “cause and effect” scenarios. It’s useful to answer “what if” type questions 
because you can adjust one cell entry to see the result. The tool is often used in finance, sales, and 
forecasting scenarios, but there are other uses. 

For example, you might be looking at your local election results and see: 

 
Votes % of Votes 

YES 4478 63.90 * 

NO 2530 36.10 



Total 7008 100 

* Needs approval from 2/3 of the voters 

In our example, the YES votes are a majority, but shy of the required 2/3 approval to win the election. 
People quickly realize they were close, but which item do they change to find out how close. What 
would’ve made a difference? 

Using Goal Seek we can change the value of one variable and see how the results change. This would allow 
you to answer these types of questions. 

 How many more YES votes were needed to win the election? 
 If 500 more people voted could the YES team have won? 

In each of these questions, the goal is to change one data value to see if the YES percentage went over that 
two-thirds mark or 67%. Rather than haphazardly changing cell values to see the results, Goal Seek can find 
the answers. 

How to Use Excel Goal Seek 

1. Create a spreadsheet in Excel that has your data. In the example below, the green cells have 

formulas to calculate the percentage and sum totals. 

Final election results 
2. Click the cell you want to change. This is called the “Set cell”. In my example, this will be D4. 

3. From the Data tab, select the What if Analysis… button 

4. Select Goal seek… from the drop down menu 

5. In the Goal Seek dialog, enter the new “what if” amount in the To value: text box. 

https://www.timeatlas.com/wp-content/uploads/goal-seek-election-start.jpg


 
 
Goal Seek input dialog 
 
In this example, we’re asking Excel to replace the contents of cell D4 which is 0.64 with 0.67. This is 
the percentage needed to win the election. Technically, we need 66.7% to win, but since Goal Seek 
has an approximation algorithm, I don’t want to run the risk of Excel rounding down. 

6.  We also need to tell Excel which cell to change. Since we wanted to know the number of YES 

votes, we’ll click C4. 

 
 

https://www.timeatlas.com/wp-content/uploads/goal-seek-set-cell.jpg
https://www.timeatlas.com/wp-content/uploads/goal-seek-change-cell.jpg


Changing the percentage value to see the impact 
 

7. Click OK. Excel will overwrite the previous cell value with the new one. 

Goal 
Seek returns new values 

8. If you wish to accept the new value, click OK. 

Excel Tip #10 - Watch Window 

Have you ever changed assumptions in a workbook and then rearranged the workbook or 
worksheets to view the impact of the change on some calculation of interest, only to change the 
assumptions again and again, each time rearranging the workbook to view the results? The 
Watch Window allows users to view in the current window the changes in other cells resulting 
from changes in assumptions. In fact, the Watch Window allows users to track cell properties of 
every type (workbook, worksheet, defined name, cell, value, and formula), while the cells are out 
of view. Essentially, the Watch Window is a cell-management tool, providing users with 
information regarding selected cells in the current or other workbooks. 

Click Watch Window on the Formulas tab of the Ribbon to open the Watch Window. In 
default, the Watch Window floats on the face of the worksheet, but it can be docked on any edge 
of the worksheet by dragging it to the desired location. Cells or ranges of cells can be added to 
the Watch Window by highlighting the cells of interest and clicking Add Watch as shown in 
Figure 1. 

https://www.timeatlas.com/wp-content/uploads/goal-seek-answer.jpg


 

Defined watches are saved when a workbook is saved so that they will be available the next time 
the workbook containing them is opened, even if the Watch Window has been closed prior to 
saving the workbook. 
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